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FOR PRODUCTS PURCHASED IN UNITED STATES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (Stored).
For single-user computers or workstations attached to a network, the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

On a multi-user computer, the quantity of the Software "in use" is
considered to be the maximum number of sessions executed at any
one time.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work, or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education or charitable institution pricing program, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If for any reason you are
dissatisfied with the software, return the product package, with proof
of purchase, to your reseller within 90 days for a full refund. If any
materials or media in this package are defective, return them to
Novell within 90 days of the date of purchase, and they will be
replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT
WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation of liability.
As a result, these limitations may not apply to you if prohibited by
the laws of your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions. This Agreement shall be governed by
the laws of the State of Utah.

U.S. GOVERNMENT RESTRICTED RIGHTS
The Software and any accompanying materials are provided with
Restricted Rights. Use, duplication, or disclosure by the Government
is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The
Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c) (1) and (2) of the Commercial
Computer Software—Restricted Rights at 48 CFR 52.227-19, as
applicable. Contractor/manufacturer is Novell, Inc. at the address
below.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399.



FOR PRODUCTS PURCHASED IN ALL OTHER COUNTRIES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device. For single-
user computers or workstations attached to a network, the quantity of
the Software "in use" is considered to be the greater of (i) the
maximum number of computers on which the Software is Loaded at
any one time, or (ii) the maximum number of computers on which
the Software is stored. On a multi-user computer, the quantity of the
Software "in use" is considered to be the maximum number of
sessions executed at any one time.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education institution or charitable institution pricing program, you
may not create an extra copy of the Software under this provision for
use on a home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If any materials or media in this
package are defective, return them within 90 days of the date of
purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL
NOVELL BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY LOST PROFITS, LOST SAVINGS, OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation. As a result,
these limitations may not apply to you if prohibited by the laws of
your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
contact your local WordPerfect office or authorized distributor, or
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.



FOR PRODUCTS PURCHASED IN AUSTRALIA-NEW ZEALAND
SOFTWARE LICENCE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered “in use” when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (Stored).
For single-user computers or workstations attached to a network, the
quantity of the Software “in use” is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

On a multi-user computer, the quantity of the Software “in use” is
considered to be the maximum number of sessions executed at any
one time.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorised use of this
Novell software product. You may also make an archival copy of the
Software for each licence obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorised to use a copy of the Software on a home or
portable computer, provided the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
educational institution or charitable institution pricing, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATIONS OF LIABILITY
A. This Part A is subject to provisions of Part B which follows
below. This Software is licensed AS IS. If any materials or media in
this package are defective, please return them within 90 days of the
date of purchase, and they will be replaced free of charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL
NOVELL BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY LOST PROFITS, LOST SAVINGS, OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORISED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

B. Trade Practices Act. Where any legislation, such as the Trade
Practices Act 1974, implies into this Agreement any condition or
warranty and that legislation avoids or prohibits provisions in a
contract excluding the application of the condition or warranty, the
liability of Novell for any breach of the condition or warranty is
limited at the option of Novell to any one or more of the following:
a) if the breach relates to goods, replacing the goods or the payment
of the cost of acquiring equivalent goods or repairing the goods or
payment of the cost of repairing the goods; b) if the breach relates to
services, the supplying of the services again or the payment of the
cost of having the services supplied again.

Nothing in this Agreement is intended to restrict or exclude any
liability of Novell under Part VA of the Trade Practices Act 1974.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programmes for educational or charitable organisations,
please contact your local WordPerfect office or authorised
distributor, or write to WordPerfect, Novell Applications Group,
Attn. Sales Center, 1555 N. Technology Way, Orem, Utah 84057-
2399 U.S.A.



FOR PRODUCTS PURCHASED IN UNITED KINGDOM
SOFTWARE LICENCE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (Stored).
For single-user computers or workstations attached to a network
(Network Stations), the quantity of the Software in use is considered
to be the greater of the maximum number of Network Stations that
have the Software Loaded at any one time, and the number of
Network Stations that have the Software Stored. For a multi-user
computer, a "use" is counted for every session of the Software
running on the computer.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

SPECIAL PROVISIONS
Novell grants you a special licence to place an extra copy of the
Software on a home or laptop computer, as long as the extra copy is
never loaded at the same time the Software is loaded on the primary
computer on which you use the Software. Special licensing
provisions may apply for a qualified educational or charitable
institution.

LIMITED WARRANTY/LIMITATION OF LIABILITY
If you enter into this Licence Agreement as part of a consumer
transaction: if any materials or media in this package are defective,
return them within 90 days of the original date of purchase, and
Novell will replace them at no charge. THE FOREGOING DOES
NOT AND WILL NOT AFFECT YOUR STATUTORY RIGHTS
AS A CONSUMER.

If you do not enter into this Licence Agreement as part of a consumer
transaction: THIS SOFTWARE IS LICENCED AS IS. The right to
use the Software is granted without any further warranty, condition,
representation, or other term express or implied relating to the
performance, quality, or fitness for use of the Software or written
materials accompanying the Software. Novell shall not be liable for
any loss or damage of any kind (other than personal injury or death)
arising from use of the Software or accompanying written materials
or from errors, deficiencies, or faults therein, whether such loss or
damage is caused by negligence or otherwise.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used

under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organisations, please
contact your local WordPerfect office or authorised distributor, or
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.



FOR PRODUCTS PURCHASED IN CANADA (ENGLISH)
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

For a single-user computer or workstation not attached to a network,
or for a network server, the Software is considered "in use" when any
portion of the Software is either loaded in memory or virtual memory
(Loaded) or stored on a hard disk or other storage device (stored).
For single-user computers or workstations attached to a network, the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

On a multi-user computer, the quantity of the Software "in use" is
considered to be the maximum number of sessions executed at any
one time.

For each license obtained under this Agreement, you are authorized
to use either the Canada—English or the Canada—French version of
the software, or both, in support of a single user at any one time.
Software and documentation for both language versions may be
obtained by contacting WordPerfect, Applications Division of
Novell, Inc., at the address listed below.

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work, or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education or charitable institution pricing program, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If for any reason you are dissatisfied
with it, return the product package, with proof of purchase to your
reseller within 90 days of the date of purchase for a full refund. If
any materials or media in this package are defective, return them to
Novell within 90 days, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL
NOVELL BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY LOST PROFITS, LOST SAVINGS, OR OTHER

INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation. As a result,
these limitations may not apply to you if prohibited by the laws of
your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement shall be unlawful, void, or
unenforceable, then that provision shall be deemed severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
contact your local WordPerfect office or authorized distributor, or
write to WordPerfect, Novell Applications Group, Attn. Sales Center,
1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.



FOR PRODUCTS PURCHASED IN CANADA (FRANCAIS)
CONTRAT DE CONCESSION DU DROIT D'UTILISATION DES LOGICIELS

EN VERSION FRANÇAISE ACHETÉS AU CANADA

TERMES ET CONDITIONS D'UTILISATION
Novell, Inc. (Novell), vous concède le droit d'utiliser le Logiciel,
conformément au nombre de copies et à la plate-forme spécifiés par
le Formulaire de preuve d'achat inclus dans le coffret du Logiciel. Si
le Logiciel constitue une mise à jour d'un produit de WordPerfect,
Novell vous concède le droit d'utiliser la présente version ou la
version antérieure du Logiciel, mais non ces deux versions
simultanément. Le présent Contrat de concession annule ou remplace
tout contrat antérieur.

Pour les ordinateurs monopostes ou les stations de travail non
connectées à un réseau, ou pour les serveurs d'un réseau, le Logiciel
est réputé être utilisé lorsque tout ou partie du Logiciel est, soit
Chargé en mémoire virtuelle, soit Enregistré sur disque dur ou sur
toute autre forme de support. Pour les ordinateurs monopostes et les
stations de travail connectées à un réseau, le Logiciel est réputé être
utilisé sur chaque station du réseau sur laquelle le Logiciel est, soit
Chargé, soit Enregistré. Pour les ordinateurs à usage collectif, chaque
exécution du Logiciel sur l'ordinateur est réputée constituer une
utilisation du Logiciel.

Sur les ordinateurs multipostes, le Logiciel est réputé être utilisé sur
chaque station sur laquelle le logiciel est exécuté.

Toute licence, octroyée selon les termes de cet accord, autorise
l'utilisation de la version canadienne-anglaise ou de la version
canadienne-française du logiciel, ou des deux versions, par un seul
utilisateur, à tout moment. Le matériel et la documentation des deux
versions peuvent être obtenus auprès de WordPerfect, Applications
Division of Novell, Inc., à l'adresse ci-dessous.

Vous êtes autorisé à réaliser une copie de la documentation écrite
jointe au Logiciel pour lequel vous disposez d'un droit d'utilisation.
Vous êtes également autorisé à réaliser une copie de secours du
Logiciel en raison du nombre de licences d'utilisation spécifié dans
le présent Contrat.

RESTRICTIONS
Vous ne pouvez en aucun cas louer ou céder en location le Logiciel
sans l'accord écrit de Novell. Vous ne pouvez en aucun cas
décompiler, démonter, inverser, reproduire, créer une oeuvre dérivée,
ou autrement utiliser le Logiciel en dehors des cas expressément
prévus dans ce Contrat. Quel que soit le nombre de supports inclus
avec le Logiciel, vous n'êtes autorisé à utiliser que le nombre de
copies indiqué sur le Formulaire de preuve d'achat. L'achat de ce
Logiciel peut être réglementé par des conditions spéciales, imprimées
sur l'emballage contenant le Logiciel.

DISPOSITIONS RELATIVES AUX ORDINATEURS PERSONNELS ET
AUX PORTABLES
Vous êtes autorisé à utiliser une copie supplémentaire du Logiciel sur
un ordinateur personnel ou un ordinateur portable. Cette copie ne
doit en aucun cas être Chargée lorsque le Logiciel est Chargé sur
l'ordinateur principal sur lequel vous utilisez le Logiciel. Si le
logiciel est acheté dans le cadre du programme d'éducation, vous
n'êtes pas autorisé à réaliser une copie supplémentaire du logiciel
pour votre ordinateur personnel ou votre portable.

GARANTIES-LIMITATIONS DE RESPONSABILITÉS
CE LOGICIEL VOUS EST CONCÉDÉ EN LICENCE EN L'ÉTAT;
SI POUR UNE RAISON QUELCONQUE, VOUS N'ÊTES PAS
SATISFAIT, VOUS DISPOSEZ D'UN DÉLAI DE 90 JOURS, À
COMPTER DE LA DATE D'ACHAT, POUR RETOURNER LE
LOGICIEL, Y COMPRIS TOUS COMPOSANTS RELATIFS,
ACCOMPAGNÉ DU FORMULAIRE DE PREUVE D'ACHAT À
VOTRE REVENDEUR, ET VOUS SEREZ INTÉGRALEMENT

REMBOURSÉ. EN OUTRE, NOVELL S'ENGAGE À
REMPLACER GRATUITEMENT TOUTE DISQUETTE OU
ÉLÉMENT DÉFECTUEUX CONTENU DANS L'EMBALLAGE
QUI SERA RETOURNÉ DANS UN DÉLAI DE 90 JOURS, À
COMPTER DE LA DATE D'ACHAT.

TOUTE AUTRE GARANTIE, EXPRESSE OU IMPLICITE, Y
COMPRIS TOUTE GARANTIE IMPLICITE D'APTITUDE À LA
COMMERCIALISATION OU D'APTITUDE À UNE
UTILISATION PARTICULIÈRE, EST EXPRESSÉMENT
EXCLUE. EN AUCUN CAS, NOVELL NE SAURAIT ÊTRE
RESPONSABLE DES DOMMAGES DIRECTS OU INDIRECTS,
Y COMPRIS TOUTE PERTE DE PROFIT OU DE BÉNÉFICE OU
AUTRES DOMMAGES INDIRECTS OU ACCESSOIRES
CAUSÉS PAR L'UTILISATION OU L'IMPOSSIBILITÉ
D'UTILISATION DU LOGICIEL ET CE, MÊME SI NOVELL OU
L'UN DE SES REPRÉSENTANTS AGRÉÉS A ÉTÉ AVERTI DE
LA POSSIBILITÉ DE TELS DOMMAGES.

Certaines juridictions ne permettent pas l'exclusion ou la limitation
de garantie implicite ou la limitation de responsabilité pour des
dommages indirects ou accessoires. En outre, certaines juridictions
prévoient des dispositions particulières relatives à la protection du
consommateur, lesquelles pourraient remplacer les dispositions qui
précèdent. En conséquence, la limitation de responsabilité peut,
conformément à la loi en vigueur dans votre juridiction, ne pas vous
être applicable.

ASSISTANCE TECHNIQUE
Dans le cadre de sa politique d'assistance technique, Novell
s'efforcera de répondre aux questions d'ordre technique concernant
le Logiciel. Cependant, il est convenu que ce service ne constitue
qu'une obligation de moyen et que Novell ne saurait satisfaire toute
demande d'assistance. Novell ne supportera le Logiciel que dans la
mesure où celui-ci est utilisé dans les conditions et selon les
configurations matérielle et logicielle pour lesquelles il a été conçu.
Les services offerts par l'Assistance technique peuvent être altérés
sans préavis.

GÉNÉRAL
Au cas où une disposition quelconque de ce contrat serait illégale,
nulle ou non exécutoire, pour quelque raison que ce soit, cette
disposition sera réputée non écrite, et la validité et le caractère
exécutoire des autres dispositions de ce contrat n'en seront pas
affectés.

RÉPONSES À VOS QUESTIONS
Si vous avez des questions à propos de ce Contrat, ou à propos des
conditions spéciales accordées aux établissements scolaires et aux
organisations caritatives, veuillez contacter la filiale dont vous
dépendez, ou votre distributeur agréé, ou écrire à WordPerfect,
Novell Applications Group, Attn. Sales Center, 1555 N. Technology
Way, Orem, Utah 84057-2399 U.S.A., ou appelez le (800) 321-2318.



WordPerfect Offices
Asia (Covers Indonesia, Malaysia,
and Singapore)
WordPerfect Asia, Regional Office
75 Science Park Drive,
#02-04 CINTECH II
Singapore 0511

Tel: (65) 773 2622
Fax: (65) 773 1622

For toll free customer support for the
following areas:
Indonesia: 00800 656585
Malaysia: 800 1090
Singapore: 773 1400

Austria
WordPerfect Österreich
Theresianumgasse 7
A-1040 Vienna
Austria

Tel: (43 1) 504 5200
Fax: (43 1) 504 5211

Australia (Also covers New
Guinea and New Caledonia)
WordPerfect Pacific, Regional Office
Building 2
25 Sirius Road
Lane Cove NSW 2066
Australia

Tel: (61 2) 415 5222
Fax: (61 2) 418 7505

Belgium/Luxembourg
WordPerfect Belgium
Manhattan Office Tower
Avenue du Boulevard 21 bte 9
Bolwerklaan 21 bus 9
1210 Brussels
Belgium

Tel: (32 2) 217 48 54
Fax: (32 2) 218 83 53

Brazil
WordPerfect Brasil
Rua Dr. Luiz Migliano, 1110, Conj.
601/602
São Paulo - SP
05711-001
Brasil

Tel: (55 11) 844 4938
Fax: (55 11) 844 4257

Chile
WordPerfect Chile
Avda Pedro de Valdivia 176
Providencia
Santiago
Chile

Tel: (56 2) 233 6898
Fax: (56 2) 233 2611

Denmark
WordPerfect Danmark
Helsingørsgade 52
3400 Hillerød
Denmark

Tel: (45) 42 25 11 99
Fax: (45) 42 25 00 58

Europe
WordPerfect Europe, Regional Office
Barbizonlaan 25
2908 MB Capelle a/d IJssel
The Netherlands

Tel: (31) 10 40 70 100
Fax: (31) 10 45 66 255

Finland
WordPerfect Finland
Sinimäentie 10 C
02630 Espoo
Finland

Tel: (358 0) 502 951
Fax: (358 0) 502 95300

France
WordPerfect France
Les Fjords, Immeuble le Nobel
19, avenue de la Norvège
Z.A. de Courtabœuf
B.P. 353
91959 Les ULIS cedex
France

Tel: (33 1) 69 29 10 10
Fax: (33 1) 69 29 01 10

Germany
WordPerfect Software GmbH
Frankfurter Straße 21-25
65760 Eschborn
Germany

Tel: (49 6196) 9 04 01
Fax: (49 6196) 4 60 03
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Hong Kong (Also covers China,
Taiwan, and the Philippines)
WordPerfect Asia
30/F Tower A
Times Square
Causeway Bay
Hong Kong

For toll free customer support for the
following areas:
Hong Kong: 800 3350
Taiwan: 0080 651042

Italy

WordPerfect Italia
Corso Sempione, 2
20154 Milano
Italy

Tel: (39 2) 336381
Fax: (39 2) 3310 6190

Japan
WordPerfect Japan
Meisei Building 1F
8-9 Sakuragaoka
Shibuya-ku, Tokyo 150
Japan

Tel: (81 3) 3780 0515
Fax: (81 3) 5489 7349

Latin America
WordPerfect América Latina,
Regional Office
1555 North Technology Way
Orem, Utah 84057-2399
U.S.A.

Tel: (801) 222 4200
Fax: (801) 222 4277

Mexico
WordPerfect México
Rio de la Plata #32
Colonia Cuauhtémoc
México D.F. 06500
México

Tel: (52 5) 286 5680
Fax: (52 5) 286 5630

Netherlands
WordPerfect Nederland
Barbizonlaan 25
2908 MB Capelle a/d IJssel
The Netherlands

Tel: (31) 10 40 70 100
Fax: (31) 10 45 66 255

Customer Support:
WP (10)-4070777
DP, OF, etc. (10)-4070766
VAX, DG, UNIX (10)-4070755

Norway
WordPerfect Norge
Postboks 6779
Rodeløkka
0503 Oslo
Norway

Tel: (47 22) 22 40 10
Fax: (47 22) 22 40 13

Portugal
WordPerfect Portugal
Rua Latino Coelho, Nº 1
Edifício Aviz, Bloco A3-9º Dtº
1000 Lisboa
Portugal

Tel: (351 1) 315 26 66
Fax: (351 1) 315 30 67

South Africa (Also covers
Botswana, Lesotho, Malawi,
Mozambique, Namibia, Swaziland,
Zambia, and Zimbabwe)
WordPerfect South Africa
3rd Floor San Clare Building
Dreyer Street
Claremont, 7700, Cape Town
South Africa

Tel: (27 21) 658 4111
Fax: (27 21) 658 4200

Spain
WordPerfect Ibérica
Dr. Joaquín Albarrán, 13-15
08034 Barcelona
Spain

Tel: (34 3) 280 00 20
Fax: (34 3) 280 60 75

Sweden
WordPerfect Sverige
Box 2063
172 02 Sundbyberg
Sweden

Tel: (46 8) 706 75 00
Fax: (46 8) 733 42 96

Switzerland
WordPerfect Switzerland
Gewerbestrasse 16
3065 Bolligen
Switzerland

Tel: (41 31) 922 07 70
Fax: (41 31) 922 04 82

Customer Support:
(031) 922 11 22
BBS:
(031) 922 05 29
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United Kingdom
WordPerfect U.K., Regional Office
Unit 9, Weybridge Business Park
Addlestone Road
Addlestone
Surrey, KT15 2UU
United Kingdom

Tel: (44 932) 850500
Fax: (44 932) 843497

United States of America
WordPerfect Corporation
1555 N. Technology Way
International Division Q1137
Orem, Utah 84507-2399
U.S.A.

Tel: (801) 222-4200
Fax: (801) 222-4277
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WordPerfect
International
Distributors

If you purchased this product within the U.S. or Canada and want to register your license outside
the U.S. and Canada with the Novell or WordPerfect International Distributor Office in your area,
entitling you to local customer support and update notices, you may be charged a maximum of
25% of the local retail price.

Argentina
Distribuidora Nacional de Informática
S.A.
Alcina 1748
1088 Buenos Aires
Argentina

Tel: (541) 372-5460, 375-1212
Fax: (541) 476-1443

Argentina
SoftMart
Florida 686
3 Piso, Dept. B
1005 Buenos Aires
Argentina

Tel: (54 1) 322 3828
Fax: (54 1) 322 4617

Caribbean
Merisel Latin America
2010 N.W. 84th Avenue
Miami, Florida 33122
U.S.A.

Tel: (305) 591-6873
Fax: (305) 599-7015

Central America
Merisel Latin America
2010 N.W. 84th Avenue
Miami, Florida 33122
U.S.A.

Tel: (305) 591-6873
Fax: (305) 599-7015

CIS
Merisel - C.A.T. Ltd.
Section 2nd
3, Kroutitskiy Val St.
Moscow 109044
Russia

Tel: (7095) 276 4714
Fax: (7095) 274 0097

Colombia
L.A.S.C.
Carrera 18 No. 79-37
A.A. 8692 Bogota
Colombia

Tel: (57 1) 218 4511
Fax: (57 1) 611 0151

Croatia (Also covers Slovenia)
Perpetuum d.o.o.
Paljetkova 18
41000 Zagreb
Croatia

Tel: (38 41) 383 377
Fax: (38 41) 381 912

Czech Republic
DCC Software Distribution s.r.o
Anglicka 17
120 00 PRAHA 2
Czech Republic

Tel: (42 2) 66312600
Fax: (42 2) 24247568

Czech Republic
TH'system a.s
28 r ijna 86
701 39 OSTRAVA 1
Czech Republic

Tel: (42 69) 6112350
Fax: (42 69) 233742

Egypt
Phoenix
P.O. Box 92
11341 Heliopolis
Cairo
Egypt

Tel: (20 2) 302 0771
Fax: (20 2) 302 0771

Greece (Also covers Cyprus)
M-DATA
Sygrou Ave. 314
Kallithea
176 73 Athens
Greece

Tel: (30 1) 959 0631
Fax: (30 1) 952 1545

Hungary
Müszertechnika
Computer Rt.
MT-1075 Budapest
Király U. 1/D
Hungary

Tel: (36 1) 1221 623
Fax: (36 1) 1225 099
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Hungary
Számalk Szoftver Disztribúció
1115. Budapest, Etele út 68.
1518. Budapest, 112.P.F.146
Hungary

Tel: (361) 185-3111
Fax: (361) 185-1294

Iceland
Einar J. Skúlason hf.
P.O. Box 8324
128 Reykjavik
Iceland

Tel: (354 1) 63 30 00
Fax: (354 1) 68 84 87

India
Pertech Computers Limited
E-46/10
Okhla Industrial Area Phase II
New Delhi 110020
India

Tel: (91 11) 681 9105
Fax: (91 11) 681 7841

Israel
Aztek Systems Ltd.
5 Netanyahu
P.O. Box 695
60200 Or Yehuda
Israel

Tel: (972 3) 695 2406
Fax: (972 3) 691 8771

Kenya
SYSCOM (Kenya Ltd.)
P.O. Box 21810
ABC Place, 2nd Floor
Waiyaki Way
Nairobi
Kenya

Tel: (254 2) 444 496
Fax: (254 2) 545 815

Korea
AIT Korea (Applied Innovative
Technology)
Seocho-Ku Seocho 3 Dong 1579-4
Jinsol Building, 2 Floor
Seoul, 137-073
Korea

Tel: (82 2) 522 1491
Fax: (82 2) 522 1495

New Zealand

Number One Software Company
P.O. Box 28-349
Remuera
Auckland 5
New Zealand

Tel: (64 9) 522 0 522
Fax: (64 9) 520 1523

Nigeria
Computer Solutions Ltd.
8, Alli Street (3rd Floor)
Tinubu Square
GPO Box 9706
Lagos
Nigeria

Tel: (234 1) 26 32 619
Fax: (234 1) 26 35 409

Nigeria (Ghana)
Sparnoon Ltd
4, Penta Court
Station Road
Borehamwood
Herts, WD6 1SL
England

Tel: 44 (81) 207 6171
Fax: 44 (81) 207 5604

Peru
Cibertec-Data S.A.
Los Laureles 391-399
Lima 27
Perú

Tel: (5114) 417828
Fax: (5114) 419331

Poland
Pro-Test Spólka z o.o.
ul. Siedmiogrodzka 5
01-204 Warsaw
Poland

Tel: (48 22) 32 35 32
Fax: (48 22) 32 08 32

Poland
Mikrokom-Soft Sp. z o.o.
ul. Pretficza 7
53-328 Wroctaw
Poland

Tel: (48 71) 619 318
Fax: (48 71) 619 720

Saudi Arabia
Saudisoft Co. Ltd.
#6 Salsabeel Street
Mushrefah District
Jeddah
Saudi Arabia

Tel: (966 2) 665 3470
Fax: (966 2) 669 4975
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Slovak Republic
DCC Slovensko s.r.o.
Pribinova 25
819 02 Bratislava
Slovakia

Tel: (42 7) 2104077
Fax: (42 7) 2104071

South America (Covers Ecuador,
French Guiana, Guyana,
Paraguay, Bolivia, and Suriname)
MERISEL/IMS
8216 N.W. 14 Street
Miami, Florida 33126
U.S.A.

Tel: (305) 591-6873
Fax: (305) 599-7015

Turkey
Opera Limited
Operatör Raif Bey Sok. No: 23/5
Rüçhan Apt. Sisli/Istanbul
Turkey

Tel: (90 212) 231 6167
Fax: (90 212) 246 5771

United Arab Emirates
Micro Computercentre
P.O. Box 4221
Dubai
United Arab Emirates

Tel: (971 4) 526 619
Fax: (971 4) 524 256

Uruguay
ATEL, S.A.
Canelones 1370 Piso 5
Montevideo 11.200
Uruguay

Tel: (5982) 92 21 18
Fax: (5982) 92 21 19

Venezuela
ENIAC, C.A.
Edificio Polar, piso 5
Plaza Venezuela
Apartado 66685, Las Americas
Caracas 1061-A
Venezuela

Tel: (582) 574 6711
Fax: (582) 574 1605

Venezuela

Grupo Beke Santos
Avenida Los Jabillos con Boulevard
de Sabana Grande, Edificio
Continental Piso #1
Caracas 1050
Venezuela

Tel: (582) 762 9971
Fax: (582) 762 3705

Venezuela
Manapro Consultores C.A.
CCCT Torre C
Piso 7, Oficina C-704
Chuao, Caracas 1064-A
Venezuela

Tel: (582) 959 0770
Fax: (582) 261 8822
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Welcome

Welcome to InfoCentral— a revolutionary tool for organizing all your information. Simple
and easy to use, InfoCentral lets you access important information quickly.

InfoCentral is available as a stand alone product or as a component of PerfectOffice™, a
suite of Business applications.

Installing InfoCentral

To install PerfectOffice™, see the installation instructions in the Up and Running Guide.

Recommended
System
Requirements

To use WordPerfect InfoCentral, you should have the following:

• IBM or IBM compatible personal computer with at least a 386 processor and 4M RAM

• Hard disk with 5-11M free disk space

• Windows 3.1 running in enhanced mode

• VGA graphics adapter and monitor

• A mouse that works in Windows

Questions and
Answers about
Installing

Which installation option should I choose?
The Standard installation is the recommended installation type for most users installing
InfoCentral for the first time. The following table will help you decide which installation
option to choose:

Installation Type Use

Standard To install InfoCentral for the first time.

Custom To customize your installation by installing only part of the
program or sets of files to directories you specify.

Update To update to a new version of InfoCentral.

I accidentally deleted some InfoCentral files. Can I reinstall only part of
InfoCentral?
Yes. Start the InfoCentral installation program, choose Custom, choose Files, then select
those files you want to reinstall.

Installing
InfoCentral

Because the InfoCentral files are compressed, you must use the InfoCentral Installation
program to place the files on your hard disk.

To install InfoCentral on your hard disk,

1 Start Windows if you have not already done so.

2 Insert the Program 1 disk into drive A (or drive B).

3 Choose Run from the File menu in the Windows Program Manager.

4 Type a:\install (or b:\install if you are installing from the b: drive), then choose OK.

5 Choose an installation type. Follow the on-screen prompts to complete the installation
process.

6 Type your name, your organization, your title, license #, iBase, country code, and area
code when prompted.
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HINT: The iBase (information base) that the installation program creates for you is named
Personal. You may change the name if you want.

7 Set up a Program Manager group by selecting the Program Group in which you want
the InfoCentral icon to appear, then choose OK.

8 If you are new to InfoCentral, we strongly recommend that you spend a few minutes
watching the quick tour that begins when installation is complete.

9 When you exit the quick tour, InfoCentral starts and displays the Quick Start coach.
This coach can help you get started quickly by adding yourself to your iBase.

When you’ve finished installing, put the original disks in a safe place. Avoid exposing them
to sunlight, dust, and magnetic fields (even televisions, telephones, and stereo speakers
contain magnets).

Things You Need to Know

What Is Included? The stand alone version of InfoCentral includes four iBases already filled with content, and
a number of iBase templates to give you a head start. Use the templates to track your own
information or to get ideas about how you can use InfoCentral.

The PerfectOffice™ version of InfoCentral includes one pre-filled content iBase
(TravelCentral™), and a few templates.

The four pre-filled content iBases included with InfoCentral are:

• ComputerCentral™ (computer.ica) Information on hundreds of companies and people
in the computer industry.

• ConsumerCentral™ (consumer.ica) Consumer service telephone numbers for
hundreds of companies.

• TravelCentral™ (travel.ica) Business travel information on hotels, airlines, convention
centers, restaurants, and more for cities around the world.

• WineCentral™ (wines.ica) Information on fine wines of the world, including regions,
price ranges, classifications, and festivals.

You can add to and change any of the information in these iBases. See Using the Pre-
Filled Content iBases later in this guide for information on how to open them.

The templates are iBases that have object categories and connection descriptions already
set up, and include a few sample objects. You can use them as a starting point for
tracking your own information. See Using the Templates later in this guide for information
on how to open them.

About InfoCentral InfoCentral is a personal information manager (PIM), plus a lot more. Intelligent
connections between people, places, and things make it easy to find any information.
Randomly scattered data becomes organized and accessible. Your world of information
will never be the same.

Once all your information is entered, you have to remember only one detail about
anything, and you can find it. Once you’ve found it, all the other information that it is
connected to it is immediately visible.

For example, you may remember that a potential client called you last Tuesday, but you
can’t remember his name. Because you logged the call in InfoCentral when it happened,
you have only to look at the calls for last Tuesday.
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The phone call is in your information base (iBase) as an event. Connected to that event is
the client’s name, the company he works for, telephone numbers, addresses, and the
notes you took while talking to him.

How it Works Information in InfoCentral is organized in discrete pieces called objects, which are then
connected to show relationships. Objects can be people, organizations, locations, cars,
software titles, letters, spreadsheets, photographs, lunch dates, meetings— anything that
has a name.

Connections between objects (people, organizations, events, and so forth) describe their
roles and relationships.

For example, Marc Sabatini is a Sales Representative for Atlantic Metals, Inc. His
business card looks like this:

Objects

Connection

Atlantic Metals, Inc.  

Marc Sabatini 
Sales Representative 

 
5678 State Street 

Icecube, Alaska  87412 
(907) 555-1000        Res. (907) 555-1111

The two objects on this card are:

• Marc Sabatini, a person
• Atlantic Metals, Inc., a company

When you add an object, like a person, to an iBase, you can connect that person to other
objects in that iBase, like a company. Connections describe relationships between
objects.

For example, the connection between Atlantic Metals, Inc. and Marc Sabatini describes
him as a Sales Representative.
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Taking a Quick Tour of InfoCentral

We strongly recommend that you take a few minutes after installing InfoCentral and watch
the quick tour. The quick tour is a learning tool that will help you become more familiar
with InfoCentral.

To see any part of the quick tour from InfoCentral,

1 Choose Quick Tour from the Help menu, then choose the topic you want to view.

You can also view a segment of the quick tour by choosing Watch quick tour of... from a
Help topic. See Using Online Help later in this guide for more information.

Starting
InfoCentral

1 If you have not done so, turn on your computer and start Windows.

2 Double-click the InfoCentral program icon in the InfoCentral program group to start
InfoCentral.

You can perform most

InfoCentral tasks using the

items in the Menu bar.

Tabs let you save views of

similar types of information.

The Toolbar gives you quick

access to commonly used

features.

Adding Yourself to
the iBase

To become familiar with InfoCentral, add yourself to your iBase.

1 Click Add on the Toolbar.

2 Choose the category Person, then choose OK.

3 Type your name, then choose OK.

or

If you have already added yourself using the InfoCentral Quick Start coach, type
another person’s name, then choose OK.
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4 Complete the Adding a New Person dialog box, inserting information as shown below.

Click here to display only the

fields with information in them.

Use the scroll bar to see all the

fields.

HINT: Choose Zoom to display only the fields with information in them. This makes the
information dialog box easier to read. You can restore the blank fields to view by choosing
Unzoom.

5 Choose OK.

6 Choose No.

BASICS: Each piece of information is an object. You add people, organizations, places,
things, events, and tasks to your information base (iBase) as single information objects.
An object is anything with a name. A person is an object. A company is an object. A
meeting is an object.

Objects fall naturally into different categories. Person objects are different from
organization or event objects.

7 Practice: Follow the steps above to add one of your friends.

Making
Connections

You make connections between objects that relate to one another. For example, a job title
can be a connection between a person and a company. A family relationship can be a
connection between two people.

1 Select your name.

2 Click Connect on the Toolbar. The insertion point changes to the Connection pointer.

Connection pointer

3 Double-click the other person you just added.
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4 Select the Friend/Friend relationship (or any appropriate relationship), then choose
OK.

5 Complete the Connection Information dialog box, then choose OK.

BASICS: In InfoCentral, you store information on connections as well as on objects. You
should carefully distinguish which information goes where. For example, a home
telephone number is stored with a person object. A person’s office telephone number is
stored with the job title connection between that person and the employing company. The
company’s main telephone number is stored with the company object.

Making Connections While You Add
To add something and make a connection in a single process,

1 Click Add on the Toolbar.

2 Add something as described in Adding Yourself to the iBase, steps 1-5 above. This
time, add an event or activity that is related to your company, such as a presentation or
company picnic.

3 Choose Yes when asked if you want to connect this event to anything else.

4 Double-click your company name to connect it to the event.

5 Select the appropriate connection, then choose OK.

6 Complete the Connection Information dialog box, then choose OK.

7 Choose No to indicate that you do not want to connect the event to any other person,
organization, or thing.

Seeing Every
Connection

InfoCentral displays information in outline format, from the “point of view” of one object that
you specify. That object is displayed at the top, and all the connected information is shown
beneath it. Connected information need not be displayed on the screen. Objects with
undisplayed connections have a plus (+) button next to them. A minus (-) button means all
immediate connections are displayed, and a dot (•) button means the object has no
connections beneath it.

When you want to see all the connections to just one object, click Hoist on the Tollbar.
Hoist moves the selected object to the top of the screen and displays all information in the
iBase that is connected to the object. All other information is removed from view.

1 Select an object.

2 Click Hoist on the Toolbar.
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HINT: If you want to return to the view before you used Hoist, click Undo on the Toolbar.

A - indicates that every

connected object is visible.

Click to hide the objects.

A • indicates that there are

no other objects connected

to this object.

A + indicates that there are

unseen objects connected to

this object. Click to view the

objects.

Finding Things To locate anything in your iBase,

1 Click FastFind on the Toolbar.

2 Type the name or the first few letters of the name of whatever you want to find.

3 Choose a search type (Find All, Find People, Organizations, Places/Things, or Find
Events).

The search might find several objects that match the initials or other text that you typed.
The object you are looking for should be among them.

Exiting InfoCentral To exit InfoCentral,

1 Choose Exit from the File menu.

Getting Help

When you need information, online Help is your best solution. It’s convenient, sensibly
organized, and easy to use. Help is structured in a way that makes finding the information
you need quick and enjoyable.

Using Online Help Help appears in a separate window on your screen. For quick access, you can keep the
Help window displayed on top of the application you’re working in. Help is also context
sensitive, which means that you can access Help wherever you are in the program,
including menus and dialog boxes.

To use context-sensitive Help,

1 Press F1.

2 Place the pointer on the item you want information about, then click.
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Contents
Use Contents to access the main components of Help. You can think of it as the table of
contents of Help.

To access a Help component,

1 Choose Contents from the Help menu.

Icons help distinguish the

components of Help.

2 Click a Help icon.

How Do I
When you need information about performing a specific task, use How Do I. The
information in How Do I is organized into books, chapters, and pages and displayed in an
expandable outline.

Click a book to view the

chapters.

Click a chapter to view the

tasks.

Click a task to read the Help

topic.

Help topic

To find steps for performing a specific task, start at the book level. Each book listed in
How Do I represents a category of tasks.

1 Click a book to open it.

Chapters contain specific tasks, or pages. (Some books contain only pages.)

2 Click a chapter to see the list of pages.

The pages represent individual Help topics.

3 Click a page to see the corresponding Help topic.
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Clicking an open book or chapter closes it. Clicking Open Books at the top of the How
Do I window displays all levels of How Do I (books, chapters, pages). Clicking Close
Books closes all books, leaving only book titles displayed.

Search for Help on
Use Search for Help on to find information by typing in a feature name, a keyword, a
synonym, or a phrase.

1 Type a keyword or phrase for the subject that interests you.

Possible keywords appear

here.

2 Select a keyword from the keywords list, then choose Show Topics.

A list of related Help topics appears in the lower part of the dialog box.

Topics list

3 Select a topic from the topics list, then choose Go To.
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Additional Help
Additional Help contains supplementary information such as Tips and Tricks, Customer
Support, Glossary, Keystrokes, Common Questions, What’s New, Available Products, and
other useful information.

Click a letter to display a list

of program terms.

Click a term to display a pop-

up definition.

Using Help
This section describes the elements of a Help topic (jump terms, pop-up definitions, icons),
and shows you how to use them.

Click dot-underlined text to

view a pop-up definition.

Click underlined text to "jump"

to another topic.

Click the light-bulb icon to

view a hint.

Coaches
Use Coaches to learn how to perform specific tasks. The Coach guides you through a
task one step at a time.

1 Choose Coaches from the Help menu.

2 Select a Coach, then choose OK.

3 Follow the on-screen prompts to complete the task.

Common Help Tasks
The following table describes actions you can perform when using Help.

To do this when Help is open: Do this:

View a pop-up explanation Click a dot-underlined word or phrase.
You may also be able to click graphics
and view a pop-up explanation.
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To do this when Help is open: Do this:

Jump to another topic Click an underlined word or phrase.

View a hint Click the hint (light bulb) icon.

Keep Help on top while you work in a
document

Choose Always on Top from the Help
menu in the Help window.

Return to the topic you viewed last Click the Back button.

Choose from a list of recently viewed
topics

Click the History button.

Print the current Help topic Click the Print button.

Copy the current Help topic to the
Clipboard

Choose Copy from the Edit menu in the
Help window.

Add a note to the current Help topic Choose Annotate from the Edit menu in
the Help window, type your note, then
choose Save.

Read a note that has been added to a
topic

Click the paper clip icon above the
purpose statement.

Delete a note that has been added to a
topic

Click the paper clip icon above the
purpose statement, then choose Delete.

Add a bookmark to the current Help topic Choose Define from the Bookmark
menu, type a name for the bookmark,
then choose OK.

Move to a bookmark that has been added
to a topic

Choose the bookmark name from the
Bookmark menu in the Help window.

Delete a bookmark that has been added
to a topic

Choose Define from the Bookmark
menu, select the bookmark name in the
list box, then choose Delete.

Displaying Help Always on Top
For quick access, you can keep the Help window open on top of the application you’re
working in until you exit.

1 Choose Always on Top from the Help menu in the Help window.
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When you click the document window, the document becomes active, but the Help window
remains on top.

HINT: You can size and drag the Help window to see the area of the document you are
working on.

Printing Help Topics

1 Choose Print Topic from the File menu in the Help window.

or

Click the Print button in the Help window.

Using Quick Tour If you need basic information about InfoCentral, you can access a quick tour segment from
the Help menu and from many Help topics. The quick tour includes the following
InfoCentral basics: fundamentals, adding and connecting, finding, using the calendar,
connecting information to your files, organizing, using the pre-filled content iBases, and
using Help.

1 Choose Quick Tour from the Help menu, then choose the quick tour segment you
want.

or

Click a quick tour topic from a Help topic, such as Watch quick tour of Adding and
Connecting.

You can access quick tour segments from the Help menu, or directly from Help topics.

Click here to watch a quick tour

segment relating to the current

topic.
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Writing Your Own
Help

When your insertion point is in various fields in dialog boxes, you can see hints at the
bottom that tell you what to enter into the field. Also, you can press Shift+F1 to get
additional help about the field the insertion point is in. You can
use Contextual Help and Hint to write your own Help about fields you set up in dialog
boxes.

Contextual Help appears

when you select a field and

press Shift+F1.

Contextual Hints appear at the

bottom of the dialog box.

To write your own help,

1 Right-click an object, then choose Information.

2 Tab to a field in the Object Information dialog box.

3 Choose Setup Field.

4 Choose Field Properties, then choose OK.

5 Type a brief description or hint for the current field in the Contextual Hint text box.

6 Type more extensive helps and hints in the Contextual Help text box.

7 Choose OK.
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